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

Annual Open House
Macs and Snacks

Meeting Notes
The NWAP April board meeting will be 

June 2nd at 7:00 p.m. at the President’s 
home. 

The New User Group June 4th at 7:00 p.m. 
will offer a chance to review, to preview, 
and to consider All Things Mac.

New User
Meeting
Thursday
 June 4th

7:00 - 9:00 p.m.


Night of the Round 
Table - Q & A

Meeting 
Locations

The New User & 
General Meetings 
are typically held 
at the Lakewood 

Public Library
Located at the south-

west corner of Gravelly 
Lake Drive and Wildaire 

Road. 
http://www.

nwapplpkrs.org
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convenience was not a factor in Mother 
Earth's schedule.

Forty years ago the Apollo 10 Mission 
proved the concept for a landing on the 
Moon and then making a rendezvous 
with an orbiting “mother ship” for the 
return to Earth.

Hawaii became our 50th State fifty years 
ago this summer, a few months after 
Alaska had been officially admitted to the 
Union. Folks in these former U.S. Territo-
ries had lots of changes to look forward 
to, even as  statehood bestowed new 
rights and responsibilities on them. 

Sixty years ago the Berlin Airlift had 
finally proven its point. Russia relented 
and began again to permit the Allies to 
use surface routes to reach Berlin. After 
nearly a year of flying ‘round the clock air 
transport missions, planes of the Ameri-
can, British, French, and other Allies had 

Word Wrap
By Bob Moffat  June 2009

June is a month of changes. We be-
gin summer vacation season. We begin 
the post-graduation phase of our lives. 
We begin the summer evening grilling 
season. 

These days events swirl past me and 
leave me hoping someone noted the 
license plate of the ten-ton truck that 
knocked me down. Consider all the 
things that have changed our lives 
since last June. Economics, politics, 
sports, ecology, and technology are 
among the fields where  game-
changing events have reshaped our 
lives and, perhaps, the world. 

Only 29 years ago we were all adjust-
ing to ash fall and amazement after 
discovering  Mt. St. Helens was a 
REAL volcano. That June's change was 
a geological reminder that the Earth is 
neither static nor predictable: human 

http://www.nwapplpkrs.org/map/lkwdlib.html
http://www.nwapplpkrs.org/map/lkwdlib.html
http://www.nwapplpkrs.org/map/lkwdlib.html
http://www.nwapplpkrs.org/map/lkwdlib.html
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We'll spend Sunday afternoon at the Lake-
wood Library from 3:00 p.m. to 5:00 p.m. June 
14th visiting, snacking, and playing on our Macs. 
Don't miss this chance to bring your system and 
show off your favorite software or share your 
pet project with fellow members.

 Bring a snack to share while we see how fel-
low members are using their Macs. The club will 
furnish plates, utensils, and soft drinks. Mem-
bers bring a snack and, if they choose, their sys-
tem. (Remember to bring an extension cord if 
you need to power up!)

Lakewood Library June 14th, 3:00 - 5:00 p.m.

Mortvedt Session

NorthWest Apple Pickers
NWAP is an Apple Macintosh User Group which meets the second Sunday of the 

Month. Annual Dues are $35 for an individual or a family.
Send inquiries to P.O. Box 99388, Lakewood WA 98496-0388

<www.nwapplpkrs.org>

Tacoma Area PC User Group
NWAP and TAPCUG, a PC user group, are two organizations working together to 

support the Macintosh and PC platforms in the Greater Tacoma/Pierce County area. 
TAPCUG meets the second Saturday of each month. Send inquiries to: 6824 19th Street 

West PMB #170, University Place WA 98466.
<www.tapcug.org>

Articles printed in this newsletter are 
available in plain text formats and on the 
NWAP website. Some articles have been 
edited to fit space in the paper copy and 
may appear unaltered on the web site.

Original articles appearing in this 
publication are copyrighted and may be 
reprinted without prior approval pro-
vided proper credit is given. Syndicated 
articles may be reprinted but MUST be 
obtained from original source. APCUG 
articles may only be published by 
APCUG member groups and MUST be 
obtained directly from APCUG.

Names of companies and products 
used herein may be trademarked.

NWAP & TAPCUG members may 
place classified ads at no cost which will 
be run at the discretion of the editorial 
staff

Article and classified submissions 
may be sent via email to:

<brownie@nwapplpkrs.org>

Board of Directors
........................................Erick J. Camp President
..............................Stewart Beels Vice President

...................................Alice Brynestad Secretary
......................................David Putman Treasurer

.............Erick J. Camp (acting) Membership
................................................Fred Battié Director

.............................................Bob Moffat. Director
...................................Ivan Richardson Director

Special Thanks 
..........................Dawne Aho Mortvedt Coord.

.......................Stewart Beels Photography SIG
                             iWeb SIG & Website Design

.............................................David Putman Editor
Alice Brynestad and a Kindly Member or 

...................................two Red Chip & Sign-In
...................Loretta Chamberland.. Club Info

.................................Bob Moffat New User SIG,
                    Proof Reader & Assistant Editor

............................Webb Olliphant Magazine &
                                       Book Exchange Project

.........Open Position Publicity,Book Review       
............Peter Winderling Apple Ambassador

New User Report

Help & Information
...........General Club Matters  Erick Camp, 253-841-0091 (9 a.m.-4 p.m.)

.................................New User (OS 10)  Bob Moffat, 253-845-5233 (any)
...................Legacy (OS 8 & 9) Webb Olliphant, 253-584-7473 (1-9 p.m.)

.................................Editor David Putman, 253-446-1954 (9 a.m.-7 p.m.)
.........................Website Design Stewart Beels, borntocruise@mac.com

(If you need help with a particular program, please contact us
<holstein@nwapplpkrs.org>

The New User Group is half way through our 
annual review of the Mac Operating System. We 
aim to introduce new users to the Leopard 10.5 
and remind veteran users of the features added 
with the latest releases. Tips and tricks for eve-
ryone to make their Mac experience more pro-
ductive and fun.

May's program completed our two-month look 
at Internet communications by reviewing the 
features of Safari. Now it’s time for a June 
Round Table Review to handle questions and 
answers for issues our members want to discuss.

Please join us at the Lakewood Library on 
June 4th from 7:00 to 9:00 p.m.

Contact: Bob Moffat (phone 253-845-5233 or 
email ramoat@mac.com)

Join us June 12th from 10:00 a.m. to Noon at 
the Lutheran Retirement Community's Mort-
vedt Recreation Center. These monthly session 
held on the second Fridays are open to all Mac 
users whether or not they live in the complex. 
Our coaches work with small groups to give at-
tention to questions. If you have a MacBook 
bring it to the meeting, but you don't have to 
bring a computer to attend.

Mortvedt Center (1705 N. Vassault St.) June 
12th from 10:00 a.m. to Noon.

Contact: Bob Moffat (phone 253-845-5233 or 
email ramoat@mac.com)

See our website for maps and driving direc-
tions to all meetings: www.nwapplpkrs.org

June 14th is Open House!

http://www.nwapplpkrs.org
http://www.nwapplpkrs.org
http://www.tapcug.org
http://www.tapcug.org
mailto:brownie@nwapplpkrs.org
mailto:brownie@nwapplpkrs.org
mailto:borntocruise@mac.com
mailto:borntocruise@mac.com
mailto:holstein@nwapplpkrs.org
mailto:holstein@nwapplpkrs.org
mailto:ramoat@mac.com
mailto:ramoat@mac.com
mailto:ramoat@mac.com
mailto:ramoat@mac.com
http://www.nwapplpkrs.org/
http://www.nwapplpkrs.org/
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Membership Update
New Memberships: Donna Foster
Renewed Memberships: Paul Cooper, Norma Bartlett, 
Gerald May
Memberships Expiring In April & May: Kathryn Whitacre, 
Elizabeth Luce, Charles Curl, Janice Mileski, Lynn Per-
cich, Martha Strom
Memberships Expiring in June: Erick Camp,Mary & David 
Fleck, Margrit Englehartson, Mary Johnson

The meeting was called to order by President Erick 
Camp at his home at 7:03 p.m.. Present were Erick, 
David Putman, Bob Moffat, Ivan Richardson, Alice 
Brynestad, Marilynn M.Russell, and Fred Battié.

The proposed Standing rules were presented and 
passed out to each Board member for their perusal. 
Comments will be taken at the June board meeting.

The Treasurers Report Report was presented, and 
was not accepted as it is not accurate. The report 
was sent to the Board electronically. A donation of 
$125 was accepted by the Board from Lee Peden 
and John R. Walters.

Membership report was presented. Some renewals 
came in after Report was created, and therefore will 
be noted in the June Membership report. One re-
newal was paid in cash, and this will be noted in the 
June report.

Resignation of the Vice President was discussed, 
but no action was taken at this time. 

The Executive Board removed Marilynn M. Russell 
from the position of Treasurer and the Executive 
Board due to irreconcilable differences. She then 
chose to resign from the Northwest Apple Pickers.

As a result of Marilynn's leaving NWAP, the posi-
tions of Novice User Meeting Coordinator and Pub-
licity and Book Review Chairman are now open.

The meeting was adjourned at 9:25 p.m.

Alice Brynestad, Secretary

Red Chip
The Red Chip current value is $106.00

Northwest Apple Pickers Website
<www.nwapplpkrs.org>

Message from the President
by Erick J. Camp

NorthWest Apple Pickers regretfully announces a 
realignment of responsibilities within the Board of 
Directors whereby the duties of the Treasurer have 
been assumed by David Putman. 

 
The Board wishes to recognize the longstanding 

contributions that Marilynn M. Russell has made 
over the years within the NorthWest Apple 
Pickers. Her passion for teaching and community 
service led to her excellent work as the leader of the 
Novice User Group and the community recycler of 
used Apple Computers back to people and organiza-
tions in need of computer equipment.  In addition, 
Marilynn was a vocal advocate for the Apple Com-
munity and worked tirelessly to promote North-
West Apple Pickers with the South Puget Sound 
region. At this time, Marilynn has announced that 
she is also leaving these other activities.  Her talent 
and dedication will be missed and she has the 
Club's gratitude for her work.

The duties of membership will be assumed by the 
Club's President.

May 17th General Meeting
NeoOffice Handouts

Check out our website for links to download 
NeoOffice as well as materials used at the May 17th 
presentation. From the Home Page go to Pro-
jected Meetings and click on the link at the bot-
tom of the page: May 17, 2009 General Meeting 
Handouts Plus.

<www.nwapplpkrs.org>

http://www.nwapplpkrs.org/
http://www.nwapplpkrs.org/
http://www.nwapplpkrs.org
http://www.nwapplpkrs.org
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kept the citizens of West Berlin supplied with 
enough food, fuel, supplies, and hope to survive the 
Blockade. The airplanes flew more than 92 million 
miles--nearly the distance between the Earth and 
Sun--when the mission ended after 15 months.

The fallout from this summer's events may not be 
recognized for years. Will there come a day when 
“Hummer” refers only to a singer who forgets the 
words? Will the refurbished Hubble Telescope fi-
nally snap a picture of Willis waving to us from the 
canals of Mars?

Mt. St. Helens fallout in 1980 dumped abrasive 
ash downwind that was unkind to mechanical de-
vices, unhealthy for respiratory systems, but bene-
ficial to crops that grew lush from the rich nutrients 
that blanketed the fields beneath the ash cloud.

Alaska and Hawaii embraced Statehood with en-
thusiasm and optimism. Moving from territorial 
administration required the citizens to reconstruct 
the institutions that served their new statehood. 
Fifty years have been filled with changes in both 
states and placed both at the leading edge of envi-
ronmental and economic development attention. 

Russia's Berlin 1948 Blockade also had unintended 
consequences. It became an embarrassing challenge 
that thwarted her intent to chase the Allies from 
Berlin and take over Germany because--somehow--
the city was supplied successfully by air. For the 
Germans, surrounded by the ruins of World War II, 

Word Wrap -- (continued from page 1)

The May New User Group explored Safari, the 
browser that is part of OS X, reviewing some basic 
features of Safari 3, the current version, including 
options on changing the appearance, resizing display 
fonts, controlling how to show/hide the tool bars, 
and setting preferences for home page and download 
folder. 

We demonstrated ways to save web pages as ar-
chive files and to create text clippings or hyperlinks 
by dragging selections to the desktop. We created a 
dashboard widget from a live element of a web page. 
And we compared Safari to Firefox to see the simi-
larities in the two browsers' interfaces. 

Stewart Beels showed the features of Safari 4, 
which is a public beta version of the next generation, 

New User Review - Apple‘s Safari

the Berlin Airlift confirmed the Allies' commitment 
to rebuilding their country: their view of the Allied 
occupation forces underwent a change for the bet-
ter.  For the Allies, the Airlift was one more confir-
mation of the need for an alliance, which became 
NATO. 

In years to come Russia would build a wall to con-
trol movement between East and West. In another 
June, a dozen years after the Airlift, “Ich ben ein 
Berliner” signaled that the spirit of the Airlift was 
enduring. Eventually, forty years after the Blockade 
failed, so did the wall.

Will 2009 bring watershed moments? Of course! 
At every level: from the June weddings and gradua-
tions which will mark personal and family mile-
stones to the decisions in board rooms and capitals 
around the world. Perhaps we'll note the unin-
tended consequences years from now. 

Look around. Is someone you know because of 
today's economics about to choose a different ca-
reer (which may well result in them winning a No-
bel Prize--or an Oscar, or the absolutely perfect 
partner--instead of plodding along until they retire 
from the job they always thought they wanted.) 

Along with rising smoke from burgers charring on 
patio grills let us celebrate the rising spirits which 
June traditionally has lofted. 'Tis the season for 
changes big and little. We'll deal with the conse-
quences later.

in a side-by-side dueling projectors comparison 
with Safari 3. Two of the most visible changes in-
clude the relocation of tabs to the top of the win-
dow and a thumbnail view of most frequently vis-
ited web pages which extends the usefulness of 
Bookmarks. If history is any guide, Safari 4 will 
ship with the next version of the OS X, 10.6 Snow 
Leopard some time later this year.

During the question and answer session Erick 
Camp addressed several questions about Internet 
security risks and safe surfing practices for Mac 
users. This meeting completed our two-session 
program covering Internet communications using 
Mail and Safari.
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There is a Mac program called VueScan that will act 
as a driver for whatever scanner you might have and 
it covers lots of them. According to the web site it 
supports more than 1,200 different scanners for 
Mac, Windows, Linux. I have a Canon LiDE30 scan-
ner which has served me well  over the past 6 or 
more years. It is light and best of all - requires no ex-
ternal power. Just plug the USB cable into your com-
puter and go to work. Problem: (Don't I always have 
problems?) The supplied Mac software on CD loads 
on my Mini but has never worked. So, I have always  
used the scanner with my PC. But, the software on 
the CD wouldn't load on my new Vista PC and the 
Canon site says "Vista is not supported with this 
scanner." Enter VueScan. Downloaded it and in-
stalled it on the PC.  Worked great except there were 
gray $ signs all over the print out. Well, I had a trial 
version. $40 for the full version of VueScan is less 
money than buying a new scanner and I might not 
find a scanner that I liked as much as the old Canon. 
Bought the upgrade and it is working fine with no 
more $ signs. I am inclined to think that the Mac  
and Linux versions would work just as well. I'll keep 
using it with the PC simply because there is a table 
for the scanner on the PC side of my computer desk 
and no room on the Mac side.

Things I hate about Windows Vista #74: I don't 
know if this happened when I first used Vista or af-
ter I reinstalled it (within 5 days) because of so many 
Trojans & viruses. Windows took over one of my  
external drives and made it a drive of its own with 
lots of directories and files. I guess I could look at a 
Vista Manual at the bookstore and find out what 
that's all about. Bothersome thing is that three years  
worth of my backups were wiped out from the drive. 
Multiple backup drives are a good thing! The 2 
month old Dell Vista machine died completely. Sta-
ples will have to fix it or give me a new one.

A new manual for me via Amazon: David Pogue's 
Mac OS X Leopard "The Missing Manual." Not one 
you would want to curl up in bed with because it's 
894 pages. Pogue says he wrote it on a MacBook lap-
top with Microsoft Word. Maybe now I'll be able to 
figure out what Spaces (or is it Stacks?) is supposed 

to do. His publisher (O'Reilly) thinks Pogue's Snow 
Leopard manual will be out in July. 

Found something fun to play with on my Mac. A 
Color Computer emulator. I’m back to writing Basic 
programs just for fun. Years ago I wrote for Com-
puter Shopper, Hot Coco (a Wayne Green mag) 
Color Computer News and Color Computer Maga-
zine. Both hardware and software articles. So, the  
Color Computer from Tandy is right up my alley. 

Check it out at 
http://members.cox.net/javacoco/index.shtml - 
Also found, at that site I think, emulators for other 
oldies including the Mac II. 

Check out radiolovers.com on the internet. Lots 
of old radio shows to listen to and it is free. How 
many of you remember "A Date With Judy?" I'm 
sure most of you don't. "It Pays to be Ignorant" 
there also. Guess that shows how old I am! In the 
music department there is an Artie Shaw  remote 
from 1938 opening with "Nightmare." Look under 
"Big Bands" and  there are four more Shaw remotes 
from the Hotel Lincoln. 

The finance program Squirrel, mentioned here a 
few times, seems to have stalled out at Ver. 0.7.3 for 
the time being. No updates for more than 2 
months.

Next issue will come from Maine. Hope I run into 
the lady with the Clamshell in the coffee house in 
Bath again. Have tried several times to get one of 
these iBooks via EBay. No luck yet.

Tom’s Tips By Tom Garcia

Move to Trash
You don't have to drag an item to the Trash (and 
risk dropping it somewhere else.) Select the item 
you want to get rid of and then in Finder menu > 
File > Move to Trash! And remember: Command-
Delete, Control-Mouse Click, or Right Mouse Click 
are other ways to move that selected item directly 
to the Trash, too.

http://members.cox.net/javacoco/index.shtml
http://members.cox.net/javacoco/index.shtml
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Monday, June 8th Program: 
Summer Pot Luck Dinner and semi-annual soft-

ware drawing. Our program will be making a light 
box for photographing 3 dimensional objects with-
out shadows. Do you have objects for eBay, 
Craigslist or your website that need to look profes-
sional? Then learn about how to build a box to dif-
fuse the light and make your object look great. We 
will actually build this box and give out directions 
at our June meeting. 
The June meeting is our “picnic” meeting. We can 

celebrate the Summer Solstice; win prizes, share a 
pot luck meal and make a cool tool for our work. No 
where else in the NorthWest will you find such a 
plethora of opportunities. And it is yours for just 
the cost of some gas in your car and three hours of 
time! Such a DEAL

Meeting will be at Cascade Print, 5:30 p.m. 
Location: 3321 S. Lawrence Street, Tacoma

South Sound Adobe User Group Links

Mac OS X Update to Leopard 10.7: Download 
either the 10.5.7 Updater to move from 10.5.6 
... or the Combo Updater to move from an ear-

lier version of Leopard 10.5.
http://www.apple.com/downloads/macosx/app
le/macosx_updates

Macworld: How to Secure your Home Network
http://www.macworld.com/article/140436/20
09/05/osxwindowshomenetworking.html

NorthWest Apple Pickers: Handouts from the 2009 
New User Group meetings available in PDF:
http://www.nwapplpkrs.org/nwap/New_User_
Group_Recap/New_User_Group_Recap.html

Peachpit Press Newsletter: A look at latest items 
and news about upcoming publications:
http://www.peachpit.com/newsletters/whatsn
ew.aspx?ni=265 

MacNightOwl Newsletter: Comment and Informa-
tion about the world of Macintosh by Gene Stein-
berg:
http://www.macnightowl.com/

TidBits—Mac News for the Rest of Us: informed 
with the latest Apple and Macintosh news that mat-
ters to you
http://db.tidbits.com/

Do you have suggestions for links to websites 
NWAP members would find useful?

 Let us know!

[Editor’s note: This announcement is from Paul Taylor] 

Mac Hints & Tips...
...is embracing the future. I now have a new website 

making use of the most modern technologies. This new 
website has every tip I've collected since 1991 -- over 
9,500 tips and growing!

You can find the new website at 
<http://machintsandtips.com>.
These tips are searchable by keyword and/or applica-

tion. You can read every Photoshop tip, every MS Word 
tip, every Leopard tip, etc, going back to System 7. Be-
cause I have unlimited space, I am adding screen shots 
to some tips, as well as a few video tips featuring Mi-
chael Davis, a long-time friend and colleague, and an 
extremely talented web designer.

There is space for your comments, just in case you 
know a better way, as well as a rating system for each 
tip. There are also links to any books that are quoted, 
which will take you directly to Amazon.com where you 
can purchase your own copy of the book, as well as 
links to my other sources if you wish to subscribe to 
them directly.

The April 2009 issue of Mac Hints & Tips is now 
available at <http://www.mac-hints-tips.com>.

http://www.apple.com/downloads/macosx/apple/macosx_updates
http://www.apple.com/downloads/macosx/apple/macosx_updates
http://www.apple.com/downloads/macosx/apple/macosx_updates
http://www.apple.com/downloads/macosx/apple/macosx_updates
http://www.macworld.com/article/140436/2009/05/osxwindowshomenetworking.html
http://www.macworld.com/article/140436/2009/05/osxwindowshomenetworking.html
http://www.macworld.com/article/140436/2009/05/osxwindowshomenetworking.html
http://www.macworld.com/article/140436/2009/05/osxwindowshomenetworking.html
http://www.nwapplpkrs.org/nwap/New_User_Group_Recap/New_User_Group_Recap.html
http://www.nwapplpkrs.org/nwap/New_User_Group_Recap/New_User_Group_Recap.html
http://www.nwapplpkrs.org/nwap/New_User_Group_Recap/New_User_Group_Recap.html
http://www.nwapplpkrs.org/nwap/New_User_Group_Recap/New_User_Group_Recap.html
http://www.peachpit.com/click.ashx?dk=34095&u=08E5EEA6-84BA-4849-B392-76DF55B8DBE9&r=%2Fnewsletters%2Fwhatsnew.aspx%3Fni%3D265%26st%3D66363
http://www.peachpit.com/click.ashx?dk=34095&u=08E5EEA6-84BA-4849-B392-76DF55B8DBE9&r=%2Fnewsletters%2Fwhatsnew.aspx%3Fni%3D265%26st%3D66363
http://www.peachpit.com/click.ashx?dk=34095&u=08E5EEA6-84BA-4849-B392-76DF55B8DBE9&r=%2Fnewsletters%2Fwhatsnew.aspx%3Fni%3D265%26st%3D66363
http://www.peachpit.com/click.ashx?dk=34095&u=08E5EEA6-84BA-4849-B392-76DF55B8DBE9&r=%2Fnewsletters%2Fwhatsnew.aspx%3Fni%3D265%26st%3D66363
http://www.macnightowl.com/
http://www.macnightowl.com/
http://db.tidbits.com/
http://db.tidbits.com/
http://machintsandtips.com
http://machintsandtips.com
http://www.mac-hints-tips.com
http://www.mac-hints-tips.com
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Book Reviews Give...
our members a chance to keep up on the latest 

releases. Review a book and it is yours to keep, 
courtesy of the publishers that cooperate with 
NWAP on these programs. 

We are looking for a member who is willing to 
coordinate this activity. Contact a Board Member if 
you can help us keep this valuable program on 
track.

Club Info emails...
keep you informed of NWAP announcements of 

interest. Thanks to Loretta Chamberland's efforts, 
members are kept up to date on the latest develop-
ments. Members: please keep us informed of your 
current email and mailing address changes so 
you won't miss an issue of the newsletter or a 
worthwhile announcement. 

(contact: mcintosh@nwapplpkrs.org)

Have You Tried ‘Em?
Quick Look

To view the content of a selected item without 
launching its application you can use Quick Look. 
That eyeball icon in the Finder window tool bar (or 
pressing the Space bar) will give you a chance to 
peek at the text or image. For details check out Mac 
Help (Finder menu Help > Mac Help > Index > 
Quick Look.)

Keyboard Viewer
How can you see an interactive view of your key-
board on your monitor. (Hint: System Preferences 
International.) Find out how to produce a special 
character like a tilde n (ñ) or a copyright symbol 
(©). For more information about setting up and 
using Keyboard Viewer look in the Mac Help Index 
for Keyboard Viewer. (From Finder menu bar > 
Help > Mac Help > Index > Keyboard Viewer.)

Display Brightness
Adjust the display brightness if your Mac has a 
built-in display (such as an iMac, MacBook, or 
MacBook Pro) through the System Preferences > 
Displays or by using the F-keys designated on your 
machine. For details check out Finder menu Help > 
Index > displays > Adjusting your display's bright-
ness.

Make a Folder
The folder is a basic organizer on your Mac. It col-
lects files (or other folders) so you can keep items 
together in ways that work for you. Click in the 
space where you want to create a new folder -- in an 
existing window, in an existing folder, on the desk-
top -- and from Finder menu > File > New Folder. 
An untitled empty folder appears ready for you to 
type a name. (See Finder menu > Help > Mac Help 
> Folders  for a bunch of clues on creating and or-
ganizing folders.)

Photographs Needed 
For Newsletter

Got Photos? Of course you do! Pick out a few and 
get them to David Putman, your newsletter editor 
so he can showcase your favorite pictures in Apple 
Pickin’s.

How are the photos chosen? The guidelines the 
editor uses for photos included in the newsletter 
have the following preferences in order:

Taken by NWAP members.
Taken in the Tacoma/Pierce County area.
Taken in western Washington.
Other photos submitted by NWAP members.
Photos selected by the Editor from any sources 

available.
Bring your photos to a meeting or email your 

photos to editor at nwap_membership@mac.com

mailto:mcintosh@nwapplpkrs.org
mailto:mcintosh@nwapplpkrs.org
mailto:nwap_membership@mac.com
mailto:nwap_membership@mac.com
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CHANGES TO CALENDARS
Check the NWAP Website For Updates. <www.nwapplpkrs.org>

Red Rock Country
Sedona AZ

by David Putman
(on well-deserved vacation)

General Mtg
3:00 p.m.

Lakewood Lib

BECS
General Mtg

7:00 p.m.

TAPCUG
General Mtg

9:30 a.m.
Senior Center

Father’s Day

New User Gp
7:00 p.m.

Lakewood Lib. 

Board Meeting
7:00 p.m.
EJCamp

SSAUG
5:30 pm

Mortvedt
Session

10:00 a.m.
Mortvedt Center

New User Gp
7:00 ­ 9:00 p.m.

Lakewood Lib

BECS
General Mtg

7:00 p.m.

TAPCUG
9:30 a.m.

Lakewood Sr. Ctr.

SSAUG
5:30 p.m.

Independence

Day

General Mtg
3:00 ­ 5:00 p.m.

Lakewood Lib

Board Meeting
7:00 ­ 9:00 p.m.

EJCamp

Mortvedt
Session

10:00 a.m ­ Noon
Mortvedt Rec Ctr.

http://www.dafirmonline.com
http://www.dafirmonline.com
http://www.minuteman-puyallup.com
http://www.minuteman-puyallup.com
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